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Analyzing and Visualizing Data with Microsoft Excel
Exam A

QUESTION 1
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might

meet the stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
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After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a Power Pivot model that contains the following tables.

Table name Column name
ProductID
Products ProductName
Price
ProductCategoryID
ProductCategory ProductCategoryID
ProductCategoryName

There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName.

Solution: You create a measure that uses the USERELATIONSHIP DAX function.

https://vceplus.com/

Does this meet the goal?

A. Yes
B. No

Correct Answer: B
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Section: (none)
Explanation

Explanation/Reference:

QUESTION 2
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might
meet the stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a Power Pivot model that contains the following tables.

Table name Column name
ProductID
Products ProductName
Price
ProductCategoryID
ProductCategory ProductCategoryID
ProductCategoryName

There is a relationship between Products and ProductCategory.

You need to create a hierarchy in Products that contains ProductCategoryName and ProductName.
Solution: You create a calculated column that uses the RELATED DAX function

Does this meet the goal?

A. Yes
B. No

Correct Answer: A
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Section: (none)
Explanation

Explanation/Reference:

References:

https://www.mssgltips.com/sqlservertip/2900/creating-hierarchies-in-powerpivot-for-excel/ https://msdn.microsoft.com/en-
us/library/ee634202.aspx

QUESTION 3
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might
meet the stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a Power Pivot model that contains the following tables.

Table name Column name
ProductID
Products ProductName
Price
ProductCategoryID
ProductCategory ProductCategoryID
ProductCategoryName

There is a relationship between Products and ProductCategory.

You need to create a hierarchy in Products that contains ProductCategoryName and ProductName.
Solution: You create a measure that uses the TSCROSSFILTERED DAX function

Does this meet the goal?

A. Yes
B. No
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Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:
QUESTION 4

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each
question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.) Exhibit:
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Your company has 100 product subcategories and more than 10,000 products.

End of repeated scenario.

You need to create a simplified view of the workbook for some users. The simplified view must only display data from FactSales, DimProduct, and DimDate.

What should you do in the data model?

A. Click Hide from Client Tools for all the tables except FactSales, DimProduct, and DimDate
B. Add the columns from FactSales, DimProduct, and DimDate to the Default Field Set

C. Create a new perspective

D. Modify the Table behavior settings for FactSales, DimProduct, and DimDate

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/hide-columns-and-tables-in-power-pivot-ddf5b1f2-2ed2-4bdb-8f78-6f94503ca87a

QUESTION 5

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each
guestion presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.) Exhibit:
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Your company has 100 product subcategories and more than 10,000 products.

End of repeated scenario.

You have a PivotChart that uses Manufacturer as the axis and the sum of SalesAmount as the values.
You need to ensure that only the top 10 manufacturers appear in the chart.

What should you do?

A. Configure the Value Filters

B. Summarize the SaleAmount field by Max
C. Change the format of the SalesAmount field
D. Create a calculated column

Correct Answer: A
Section: (hone)
Explanation

Explanation/Reference:
References: https://www.exceldashboardtemplates.com/how-to-easily-make-a-dynamic-pivottable-pie-chart-for-the-top-x-values/

QUESTION 6
DRAG DROP

You have a table that contains the following data.
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Customer Country Product Quantify
Customerl | Canada Productl 100
Customer2 | USA Product2 %0
Customerl3 | UK Product3 80
Customerl | Canada Productl 70
Customer2 | USA Product2 80
Customer3 | UK Product3 50
Customer]l | Canada Productl 60
Customer2 | USA Product2 70
Customer3 | UK Product3 60
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Country (All) -

Sum of Quantity Column Label. -

Row Labels -  Customerl Customer2 Customer3 Grand Total

Productl 230 230
Product2 240 240
Product3 230 230
Grand Total 230 240 230 700

How should you configure the PivotTable? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Select and Place:
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Fields

Country

Customers

Products

Quantity

Correct Answer:

Fields

Answer Area

Columns: | Field
Rows: Field
Values: Field
Filters: Field
Answer Area
Columns: | Customers
Rows: Products
Values: Quantity
Filters: | Country
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Section: (none)
Explanation

Explanation/Reference:

QUESTION 7
You have a table that contains data relating to exam candidates and their associated exam scores.

You need to visualize the exam data by separating the data into quartiles. The visualization must display the mean score and must identify any outliers.

Which type of chart should you use?

A. line

B. pie

C. box and whisker
D. histogram

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/create-a-box-and-whisker-chart-62f4219f-db4b-4754-aca8-4743f6190f0d

QUESTION 8
You have a KPI named Goal that calculates the sales from the previous year and multiplies the sales by 1.1.

You need to modify Goal to multiply the sales from the previous year by 1.15.

www.vceplus.com - VCE Exam Simulator - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - PDF Online


https://vceplus.com
https://vceplus.com

https://vceplus.com/ What should

you do?

A. From Power Pivot, modify the measure

B. From Power Pivot, create a new calculated column, and then modify the KPI
C. From the properties of the KPI, modify the absolute value
D

. From the properties of the KPI, modify the KPI base field

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/key-performance-indicators-kpis-in-power-view-230d7f15-731e-47a5-9938-fa0f02e6b676# toc351738129

QUESTION 9
You have an Excel spreadsheet that contains a PivotChart.

You install Microsoft Power Bl Publisher for Excel.
You need to add a tile for the PivotChart to a Power Bl dashboard.

What should you do?

From powerbi.com, click Get apps

From powerbi.com, upload the Excel workbook
From the File menu in Excel, click Publish
From the Power Bl tab in Excel, click Pin

o0 >

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
References: https://docs.microsoft.com/en-us/power-bi/service-publish-from-excel

QUESTION 10
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You have an Excel workbook that contains two tables named User and Activity.

You plan to publish the workbook to the Power BI service.

Users will use Q&A in the Power BI service to perform natural language queries.

You need to ensure that the users can query the term employee and receive results from the User table.
What should you do before you publish to Power BI?

A. From PowerPivot Settings, modify the Language options

B. From PowerPivot Settings, modify the Categorization options
C. From the Power Pivot model, edit the Synonyms

D. From Workbook Connections, add a connection

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
References: http://blog.pragmaticworks.com/optimizing-power-bi-ga-with-synonyms-phrasing-using-cloud-modeling

QUESTION 11
You open C:\Data\Data.xlsx in Excel.

When you attempt to publish the file to Microsoft Power Bl, you receive the following error message: “We couldn’t publish to Power Bl. Make sure your workbook is
saved as an Excel file (.xIsx or .xIsm) and is not password protected.”

You need to ensure that you can publish the file to Power BI.

What should you do first?

A. Decrypt the workbook

B. Copy the file to a network share

C. Add a digital signature to the workbook

D. Disable iterative calculation for the workbook

Correct Answer: A
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Section: (none)
Explanation

Explanation/Reference:
References: https://docs.microsoft.com/en-us/power-bi/service-publish-from-excel

QUESTION 12
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each
question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)

Data Sample exhibit:

DailyRepairs
WorkshopID = RepainrTypelD (v ] Hours = Revenue v |

2016-10-01 1 4 2 £ 432
2016-10-01 6 8 16 £ 4,144
2016-10-01 3 6 12 £ 564
2016-10-01 6 5 4 3 1.680
2016-10-01 5 4 12 i 1,968
2016-10-01 3 4 14 £ 854
2016-10-01 2 4 15 £ 3,030
2016-10-01 1 1 0 £ -

www.vceplus.com - VCE Exam Simulator - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - PDF Online


https://vceplus.com
https://vceplus.com

Workshops

ID = Workshop Name = Workshop Manager 8  Manager Since v) IsLatest =

1 Cambridge Alex Hankin 2012-11-10 1
2 Bedford Ben Miller 2015-04-22 1
3 Camden Kari Furse 2015-08-29 1
4 Belsize Ron Gabel 2016-02-14 1
5 Reading Josh Edwards 2009-11-07 1
6 Kilbum Karen Toh 2012-02-25 1
6 Kilburn Eva Corets 2009-06-06 0
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Dates

D n Date u Month a Year u MonthID u

20160101 2016-01-01 Jan ‘16 2016 201601
20160102 2016-01-02 Jan °16 2016 201601
20160103 2016-01-03 Jan °16 2016 201601
20160104 2016-01-04 Jan ‘16 2016 201601
20160105 2016-01-05 Jan ‘16 2016 201601
20160106 2016-01-06 Jan ‘16 2016 201601
20160107 2016-01-07 Jan °16 2016 201601
20160108 2016-01-08 Jan 16 2016 201601
20160109 2016-01-09 Jan °16 2016 201601
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RepairTypes

D [+ ] Repair Type [ |

1 Engine

2 Radiator

3 Gearbox

4 Clutch

3 Brakes

6 Tires

7 Bodywork
8 Windscreen
9 Other

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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™ Dates 7T DailyRepairs 1 Workshops
- [T7] Date ] 1o
™ Date ™ WorkshopliD ™™ Workshop Name
™ Month ™ RepairTypelD ™ Weorkshop Manager
1] Year [ Hours 7 Manager Since
™ MonthiD ™ Revenue 7 i1sLatest

[fx] Total Revenue
B Rephhlypes - [fx] Total Hours
f._. 1D —c
™ Repair Type .J

The tables in the model contain the following data:

= DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue column.

= Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always
Firsthame Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager. =
RepairTypes has a list of all the repair types = Dates has a list of dates from 2015 to 2018

End of repeated scenario.

When you attempt to create a relationship between DailyRepairs and Workshops, Power Pivot generates the following error message: “The relationship cannot be
created because each column contains duplicate values. Select at least one column that contains only unique values”.

You need to ensure that you can create a valid relationship between the tables.

What should you do?

A. In the Power Pivot model, change the data type for Workshop[ID] to General
B. In the workbook query for Workshops, add an index column
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C. In the Power Pivot model, change the Table Behavior setting for Workshops
D. In the workbook query for Workshops, filter [IsLatest] to equal 1

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
References: https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx

QUESTION 13

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each
guestion presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A

sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)

Data Sample exhibit:
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DailyRepairs

WorkshopID = RepaurTypelD = Hours = Revenue (v |

2016-10-01 1 4 2 £ 432
2016-10-01 6 8 16 £ 4,144
2016-10-01 3 6 12 £ 564
2016-10-01 6 5 + £ 1.680
2016-10-01 5 4 12 £ 1,968
2016-10-01 3 4 14 £ 854
2016-10-01 2 4 15 £ 3,030
2016-10-01 1 1 0 £ -
Workshops

1 Cambridge Alex Hankin 2012-11-10 1
2 Bedford Ben Miller 2015-04-22 1
3 Camden Kari Furse 2015-08-29 1
4 Belsize Ron Gabel 2016-02-14 1
5 Reading Josh Edwards 2009-11-07 1
6 Kilbum Karen Toh 2012-02-25 1
6 Kilburn Eva Corets 2009-06-06 0
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Dates

D ﬂ Date u Month a Year u MonthID u

20160101 2016-01-01 Jan 16 2016 201601
20160102 2016-01-02 Jan °16 2016 201601
20160103 2016-01-03 Jan 16 2016 201601
20160104 2016-01-04 Jan 16 2016 201601
20160105 2016-01-05 Jan °16 2016 201601
20160106 2016-01-06 Jan ‘16 2016 201601
20160107 2016-01-07 Jan °16 2016 201601
20160108 2016-01-08 Jan ‘16 2016 201601
20160109 2016-01-09 Jan °16 2016 201601
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RepairTypes

ID [+ ] Repair Type |

1 Engine

2 Radiator

3 Gearbox

+ Clutch

3 Brakes

6 Tires

7 Bodywork
8 Windscreen
9 Other

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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] Dates 7] DailyRepairs B2l Workshops
£ b [-J Date D ID
[T Date 7] WorkshoplD [™ Workshop Name
] Month 7] RepairTypelD 7] Workshop Manager
7 Year [T Hours [FT Manager Since
71 MonthiD ™ Revenue 7] Istatest

[fx] Total Revenue
EL] RepairTypes — [fx] Total Hours
E i - |
r:_ Repair Type

The tables in the model contain the following data:

» DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue column.

= Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firsthame Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager. =

RepairTypes has a list of all the repair types = Dates has a list of dates from 2015 to 2018

End of repeated scenario.

You create a measure named Average Revenue Per Hour that calculates the average revenue per hour.
You need to populate a cell in a worksheet to display the Average Revenue Per Hour where Repair Type is Engine.

Which Excel formula should you use?

A. =CUBEMEMBER (“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”,
“[Dimensions]. [Repair Type]. [Engine]”))
B. =CUBEVALUE (“"ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”,
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“[Dimensions]. [Repair Type]. [Engine]l”))

C. =CUBEMEMRBER (“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”,
“[RepairTypes]. [Repair Type]. [Enginel]”))

D. =CUBEVALUE (“"ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”,
“[RepairTypes]. [Repair Type]. [Enginel]”))

Correct Answer: B
Section: (none)
Explanation

Explanation/Reference:

References:
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dche0l
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_cube_cubemember_function.htm

QUESTION 14
HOTSPOT

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each
guestion presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)

Data Sample exhibit:
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DailyRepairs

WorkshopID = RepaurTypelD = Hours = Revenue (v |

2016-10-01 1 4 2 £ 432
2016-10-01 6 8 16 £ 4,144
2016-10-01 3 6 12 £ 564
2016-10-01 6 5 + £ 1.680
2016-10-01 5 4 12 £ 1,968
2016-10-01 3 4 14 £ 854
2016-10-01 2 4 15 £ 3,030
2016-10-01 1 1 0 £ -
Workshops

1 Cambridge Alex Hankin 2012-11-10 1
2 Bedford Ben Miller 2015-04-22 1
3 Camden Kari Furse 2015-08-29 1
4 Belsize Ron Gabel 2016-02-14 1
5 Reading Josh Edwards 2009-11-07 1
6 Kilbum Karen Toh 2012-02-25 1
6 Kilburn Eva Corets 2009-06-06 0
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Dates

D ﬂ Date u Month a Year u MonthID u

20160101 2016-01-01 Jan 16 2016 201601
20160102 2016-01-02 Jan °16 2016 201601
20160103 2016-01-03 Jan 16 2016 201601
20160104 2016-01-04 Jan 16 2016 201601
20160105 2016-01-05 Jan °16 2016 201601
20160106 2016-01-06 Jan ‘16 2016 201601
20160107 2016-01-07 Jan °16 2016 201601
20160108 2016-01-08 Jan ‘16 2016 201601
20160109 2016-01-09 Jan °16 2016 201601
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RepairTypes

ID [+ ] Repair Type |

1 Engine

2 Radiator

3 Gearbox

+ Clutch

3 Brakes

6 Tires

7 Bodywork
8 Windscreen
9 Other

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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f7] Dates 7] DailyRepairs £=] Workshops
] D [T Date £ D
[T Date 7] WorkshoplD [™ Workshop Name
] Month 7] RepairTypelD 7] Workshop Manager
7 Year [*7 Hours [FT Manager Since
{71 MonthID ™7 Revenue 7] Istatest

[fx] Total Revenue
EL] RepairTypes — [fx] Total Hours
= o |
r:- Repair Type
!

The tables in the model contain the following data:

» DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue column.

= Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always
Firsthame Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager. =
RepairTypes has a list of all the repair types = Dates has a list of dates from 2015 to 2018

End of repeated scenario.

To the Dates table, you need to add a calculated column named Months Ago. Months Ago must display the number of calendar months before the current month.
For example, if the current date is July 10, 2017, the Value of Months Ago will be O for all the dates in July 2017, 1 for all the dates in June 2017, and 2 for all the

dates in May 2017.
How should you complete the DAX formula? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area

CALCULATE

MONTH
YEAR

DATEDIFF

Correct Answer:

Answer Area

CALCULATE

MONTH
YEAR

DATEDIFF

(TCDAY () ) -MONTH ([Date] ) + ((YEAR(

DATE
DATESYID
DATEVALUE

(TCDAY () ) -MONTH ([Date] ) + ((YEAR(

TODAY

-

DATE
DATESYID
DATEVALUE
TODAY

())-[Year])*12 )

())-[Year])*12 )
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Section: (none)

Explanation

Explanation/Reference:

References: https://msdn.microsoft.com/en-
us/library/ee634914.aspx https://msdn.microsoft.com/en-
us/library/ee634567.aspx https://msdn.microsoft.com/en-
us/library/ee634554.aspx

QUESTION 15
You have the Excel worksheet shown in the exhibit. (Click the Exhibit button.)

Exhibit:
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- Sample Workbook - Excel

Insert Page Layout Formulas Data Review View Q Tell me what you want to do...

&D ‘*’ Calibri v[n A A === - E¢WrapText General 4

Ry ~

Paste B IU-||H- O-A- === |3 ElMerge&tCenter ~ | $ ~ % » | %3 £§ | Conditional Formata:
v Formatting~ Table~

Clipboard & Font (7 Alignment P Number M Styles

Al > [ S

4 A | 8B | C IS e e e e e

1 | EmployeelD | LogonName EmailAddress

2 1- Userl Userl.contoso.com |

3— 2 User2 User2,contoso.com ﬂ

r 3 User3 User3.contoso.com —_— = | .com

sd 4 Userd User4.contoso.com

6— 5 Users User5.contoso.com

7~ 6 Usert Userb.contoso.com

E_ 7 User?7 User7.contoso.com

Qu 8 User8 User8.contoso.com

1—0— 9 User9 UserS.contoso.com

You need to transform the data by using Query Editor.

What should you do first?

A. From the Data tab, click Flash Fill
B. From the Insert tab, click Store
C. From the Data tab, click From Table/Range
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D. From the Data tab, click Consolidate

Correct Answer: C
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/unified-get-transform-experience-ad78befd-eblc-4ea7-a55d-79d1d67cfOb3

QUESTION 16

You have an Excel workbook that has the following two workbook queries:

= A gquery named Consultants that retrieves a table named Consultants_Contact from a Microsoft SQL Server database
= A guery named Employees that retrieves a table named Employee_Contact from a Microsoft Azure SQL database

Both tables have the same columns.
You need to combine all the data from Consultants and Employees into one table.

Which command should you use?

A. Append Queries
B. Combine Binaries
C. Transpose

D. Merge Queries

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/merge-queries-power-query-fd157620-5470-4c0f-b132-7ca2616d17f9

QUESTION 17
You have 20 workbook queries that load 20 CSV files to a local computer.

You plan to send the workbook and the 20 CSV files to several users. The users will store the files in various locations.

You need to ensure that the users can change the path to the CSV files in the queries as quickly as possible.
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What should you do from Query Editor?

A. Append all the queries. Edit the source of the first query

B. Merge all the queries. Edit the source of the first query

C. For each query, create a new query that uses a reference. Modify the source of each new query
D. Create a parameter. Modify the source of each query to use the parameter

Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
References: https://www.howtoexcel.org/power-query/how-to-parameterize-your-power-query/

QUESTION 18
You have multiple workbook queries that load data from tables in Microsoft Azure SQL Database to a Power Pivot data model.

You discover that new rows were added to the tables in Azure SQL Database.

You need to ensure that the workbook has the new data.

https://vceplus.com/ What should

you do?

A. From the Data tab, click Refresh All

B. From the Power Pivot tab, click Update All
C. Close and open the workbook

D. Select a cell in the worksheet and press F5

Correct Answer: C
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Section: (none)
Explanation

Explanation/Reference:

References: https://support.office.com/en-us/article/refresh-an-external-data-connection-in-excel-2016-for-windows-1524175f-777a-48fc-8fc7-c8514b984440
QUESTION 19

You create an Excel workbook named SalesResults.xIsx. You create a workbook query that connects to a Microsoft SQL Server database and loads data to the
data model. You create a PivotTable and a PivotChart.

You plan to share SalesResult.xIsx to several users outside of your organization.
You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.

What should you do?

Modify the source of the query

Save the workbook as an Excel Binary Workbook (.xlIsb)

From Query Editor, open the Data Source and delete the credentials
Run the Document Inspector

oo

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/data-source-settings-power-query-9f24a631-f7eb-4729-88dd-6a4921380ca9

QUESTION 20
You have an Excel workbook query that loads data to a worksheet and the data model.

You need to ensure that the data is refreshed whenever you open the workbook.

What should you do?

From the File tab, click Options, and then modify the General options

From the Power Pivot model, modify the Table Behavior setting

From the File tab, click Options, and then modify the Data options

Run the Data tab, click Queries & Connections, and then edit the properties of the query

OO0 w>»
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Correct Answer: D
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/refresh-connected-imported-data-e 76a38b0-e2e1-400b-9f2f-c87b9b18c092

QUESTION 21
You have two queries named Client and Invoices. A sample of Client is shown in the following table.
ClientID ClientName
1 Clientl
2 Client2
3 Client3
< Client4

A sample of Invoices is shown in the following table.

InvoiceID | ClientID | InvoiceDate | InvoiceAmount
1 1 07-07-2017 15.99

2 1 07-09-2017 20.88

3 2 08-17-2017 5.03

4 3 08-24-2017 8.98

You need to create a new table that has the following information.
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ClientID | ClientName | InvoicelD ClientID.1 InvoiceDate | InvoiceAmount

1 Clientl 1 1 07-07-2017 15.99
1 Clientl 2 1 07-09-2017 20.88
2 Client2 3 2 08-17-2017 5.03
3 Client3 - 3 08-24-2017 8.98
- Client4 null null null null

Which join kind should you use?

A. Left Outer
B. Left Anti
C. Inner

D. Right Anti

Correct Answer: A
Section: (nhone)
Explanation

Explanation/Reference:

QUESTION 22
You have a workbook query that loads the following table
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D Key Value
1 Student Bob
1 Class 2
1 Score 80
2 Student Sam
2 Class 1
2 Score 80
3 Student Dave
3 Class 1
3 Score 80

You pivot the table on the Key column by using Value as the values column, and you receive the results shown in the following table.
D Student Class Score

1 1 1 1
2 1 1 1
3 1 1 1

You need to ensure that the data appears as shown in the following table.
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ID Student Class Score

1 Bob 2 80
2 Sam 1 80
3 Dave 1 80

What should you do?

A. Change the Aggregate Value Function of the pivot

B. Change the Data Type of the Value column

C. Select the ID column, and then click Unpivot Columns

D. Delete the Pivoted Column step. Select the Key column, and then click Unpivot Columns

Correct Answer: C
Section: (hone)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9eal-49¢1-9d95-f588221c7098

QUESTION 23
You need to create a PivotChart that has a filter as shown in the following exhibit.
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Products All v
Search ProductCategory P v

': v] All -~

= [v] Accessories
v| Bike Racks

m

v| Botties and Cages
v| Cleaners

v| Helmets

+ [v Hydration Packs
v, Locks

v| Pumps

Select Multiple Items

What should you do first?

A. From the model, create a measure

B. From Query Editor, create a function
C. From the model, create a hierarchy

D. From Query Editor, create a parameter

Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
References: https://support.office.com/en-us/article/measures-in-power-pivot-86484821-a324-4da3-803b-82fd2e5033f4

QUESTION 24
You have the following table.
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Month Number Month Name
1 January
2 February
3 March
+ April
X May
6 June
7 July
8 August
9 September
10 October
11 November
12 December

You plan to use [Month Name] as the axis in a PivotChart.

You need to ensure that whenever [Month Name] is used in a chart, the months are displayed chronologically by default.

What should you do?

A.
B
C.
D. Sort the [Month Name] column by [Month Number]

Add a calculated column named [ID] that uses the [Month Name]&[Month Number] DAX formula

. Change the Data Type of [Month Name] to Date

Sort the [Month Number] column by [Month Name]
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Correct Answer: A
Section: (none)
Explanation

Explanation/Reference:
References: https://gasperkamensek.wordpress.com/2013/04/16/sorting-months-chronologically-and-not-alphabetically-in-a-pivot-table-report-based-on-
powerpivot-data/

QUESTION 25
You have the data model shown in the Data Model exhibit. (Click the Exhibit button.)

Data Model exhibit:
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;_-_] factSales
SalesOrderlD

SalesPerson
Territory
ProductCategory
ProductSubcategory
ProductName

Color

OrderQty

OrderDate

UnitPrice

BEHBEHAB8 8B

UnitPriceDiscount
7] TotalPrice

[x] sum

v Products
ProductCategory [ProductCategory]
ProductSubcategory [ProductSubcategory]
ProductName [ProductName]

You have the PivotChart shown in the Pivot Chart exhibit. (Click the Exhibit button.)

Pivot Chart exhibit:
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20000
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Jerseys I
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Socks N
Vests

Tights =
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Locks 1
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Handiebars ===

Pumps =

Tiresand Tubes 1

Helmets E—
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Road Frames IE—
Saddies ==
Touring Frames mm
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Bike Racks ==
Cleaners 1
Road Bikes
Bio-Shorts ==
Brakes 1
Derallleurs =
Headsets 1§
Mountain Frames

Botties and Cages m

Mountain Bikes

Touring Bikes ———

mTotal

Accessories Bikes Clothing Components

‘Pfoducts v

You need to change the current view of the PivotChart to display ProductCategory only.

What should you do?

A. Right-click a bar in the PivotChart and click Expand Entire Field
B. Right-click the PivotChart and click Reset to Match Style
C. Click the + buttonD. Click the — button Correct Answer: A Section: (none) Explanation

Explanation/Reference:
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References: https://support.office.com/en-us/article/expand-collapse-or-show-details-in-a-pivottable-or-pivotchart-d70d7e70-d230-4d45-81db-1f5e39bch394
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